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Who am I? 
Joseph Sherman, Digital Accessibility Analyst, Office of Equity and Human Rights. 

joseph.sherman@portlandoregon.gov 

Open Office Hours every other Tuesday, 1pm to 3pm. Email for more information, or to set up 
consults and appointments.  

mailto:joseph.sherman@portlandoregon.gov
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Why care about accessibility? 
You want to reach the widest audience possible. You are required to provide accessible material 
under Federal, State, and local laws. 

Accessible documents 
A document or application is considered accessible if it meets certain technical criteria and can 
be used by people with disabilities. This includes access by people who have mobility challenges, 
are blind, low vision, deaf, hard of hearing, or who have cognitive difficulties. For text 
documents, we are primarily concerned with Assistive Technology users. Assistive Technology is 
any hardware or software that helps a user access digital content. Examples of Assistive 
Technology are screen readers, screen magnifiers, alternate input devices, and voice control. 

In general, properly designed html is the most accessible format. PDF files are difficult to make 
completely accessible. They are also difficult to consume via mobile devices. 

Creating accessible documents 
To ensure that documents are ultimately accessible, content authors must utilize the formatting 
and layout options within Microsoft Word and Adobe Acrobat Pro that support structural markup. 
This structural markup ensures that assistive technology software can correctly discern and 
interpret the structure of the document. 

Keep this in mind if you plan to convert a document to a PDF: 

• Prep the Word document first so that it is accessible. 
• Then convert it to a PDF. 
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• If a document needs significant remediation, it is generally easier to remediate the source 
file within Word than to work with the PDF. 

List of best practices: 
• Do not use images of text. Images of text are inaccessible to assistive technology. 
• All documents must have descriptive titles. 
• Use headings to structure and organize your document. Ensure that all heading styles are 

applied in a hierarchal manner. Only use headings with a name of Heading 1, Heading 2, 
etc. 

• Include alt text for images, charts, and graphs. Also, include captions for charts and 
graphs where applicable. 

• Try to avoid the use of text boxes. They are not accessible in Word. Use text styles to 
mimic a text box. 

• Keep tables simple --- avoid nested tables and merged cells in Word. Do not use tables for 
layout. Include column headings and specify a header row for tables. 

• Use descriptive hypertext links except for print documents or simple URLs. 
• Use bulleted and numeric lists for related items. 
• Include a table of contents for long documents (which Word can generate if you use 

styles). 
• Avoid watermarks. If you must use one, make sure that the information it contains is also 

included elsewhere in the document. 
• Be cautious as to the colors you choose. Some colors and color combinations can be 

difficult to read, especially for someone who has color blindness. Provide sufficient color 
contrast. Also, do not use color or styles alone to convey meaning. 

• Include closed captions or transcripts for any audio or video elements. 
• Provide file type and size when posting documents to the web. This allows users to decide 

whether they want to download the file. 
• Do not use the “Enter” key to create space in your document. Instead use the paragraph 

spacing options built into Word. 

Details for creating accessible Word documents 

Headings and Styles 
Paragraph headings (such as those you find in this document), provide not only visual cues to 
major topics, but they also provide a means for navigating the document by a assistive 
technology. Paragraph headings are not individually formatted (e.g., larger font size, bolded, 
and underlined), but are formatted by using styles. 

Heading levels should be applied to paragraph headings based upon their hierarchy within a 
document. For example, the following headings may be applied as follows: 

• Heading 1 – Title of document 
• Heading 2 – Major headings 
• Heading 3 – Subheadings 
• Etc. 

To apply a style to a paragraph heading: 

1. Click the Home tab. 
2. Click on the paragraph that you want to style as a heading. 
3. From the Styles section of the ribbon, click on the desired style. 
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You can modify the default styles by Right-clicking on the Style and select modify, or “Update 
Style to Match Selection” if you have already styled your content. 

Images 
Images must have a description that explains the purpose or the content of that image. This 
description, referred to as alt text (or alternate text), is read by assistive technology.  

To add alt text to an image: 

1. Right click on an image. 
2. From the menu, select: View Alt Text.  
3. In the box, type a brief description. 
4. If the image does not convey information, select the “Mark as decorative” checkbox. 

Alternative text should communicate the message conveyed by the image.  

How to Create Good Alternate Text: 

• Consider the content and function of your image. 
• If it provides content to your document, make sure that the information the image 

provides is described in the alt text. 
• Purely decorative images should have null alternative text or mark as decorative. 
• Differentiate photos from illustrations from logos, etc. 
• Do not repeat the information that is contained in the document itself into the alt text. 

If it is already in the document, that should be enough. 

 

Tables 
Do not use Tables for layout. Tables usually include column headers and may include row 
headers. Use the Insert Table command, not the Draw Table option. 
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Example of a table with column headers: 

Class List 

Name Score Date 
John Smith 90 2/12/2023 
Jane Doe 67 2/14/2023 
Eric Mann 87 2/17/2023 

 

Table Headers: 

Make your tables more accessible to assistive technology using the header row option. (Also, 
this option is useful for another purpose: If you have a table that splits across more than one 
page, it will repeat the column headings for every page on which the table appears.) 

To add a header row: 

1. Type column headings in the first row of the table. 
2. Select the first row containing the column headings. 
3. From the ribbon, select: Layout. 
4. Click the Repeat Header Rows button. 
5. In addition, select Header Row in the Table Design Tab. 

If your table has column headers, select the First Column option in the Table Design Tab. 

Charts and Graphs 
Charts and graphs should have alt text as well as a short caption when appropriate. 

Example of a chart with a caption: 

Figure 2: Ice Cream Flavor Pie Chart 

 

To add alt text to a chart: 

Vanilla
35%

Chocolate
40%

Strawberry
25%

Flavors

Vanilla Chocolate Strawberry
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1. Right click on the chart’s border. 
2. From the menu, select: View Alt Text.  
3. In the box, type a summary that explains the chart. 

 
To add a caption to a chart: 

1. Right click on the chart’s border. 
2. From the shortcut menu, select: Insert Caption. 
3. In the Caption box, type the desired text for the caption. 

 
4. Format and position the caption as desired. Put the caption before the chart when 

possible. 
5. Click OK. 

List Items 
Lists of related items should be formatted using bullets or automatic numbering. This is 
important since assistive technology will announce that there is a bulleted list and then read 
those items. Often a list can be used as an alternative to a table when presenting information.  

To create a list: 

• Type each item on a single line. 
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• Select the group of items. 
• Click the bullet or numeric bullet button. 
• Alternatively, take advantage of Word’s automatic features to make lists. 

Accessibility Checker (all Windows and Mac 2016+ Office versions) 
The Accessibility Checker is a great tool to check for problems in your Word document. It points 
out things such as missing alt text, missing table row headers, unclear hyperlink text, and more. 
It also provides instructions on how to fix any items that have been flagged as inaccessible.  

To use the Accessibility Checker: 

1. Click on the Review tab. 
2. Select: Check Accessibility. 
3. An Inspection Results pane will appear. It provides a list of errors and warnings that it found 

in the document. 

 
4. Under the errors section, click on an item. 
5. Word navigates to the item in error. 
6. In the Additional Information section of the Inspection Results pane, information is given 

explaining why the item needs fixed and how to remedy the error. 
7. Under the warnings section, click on an item. 
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8. In the Additional Information section of the Inspection Results pane, information is given 
explaining why the item needs fixed and how to remedy the error. 

9. Fix the errors and warnings as appropriate. 
10.Note that just passing the Word accessibility checker does not mean your document is 

completely accessible. Some items must be manually verified. 

Save a Word Document as a PDF 
There is more than one way to save a Word document as a PDF. You can save a document as a 
PDF by using Adobe’s Acrobat add-in or Word’s add-in. It is essential that you create an 
accessible Word document before you convert it to a PDF. Do not use “Print to PDF” as that will 
result in an untagged PDF. 

 
Adobe’s add-in often produces a better-tagged and accessible PDF (especially for more complex 
documents). If you have the full version of Adobe Acrobat Pro DC installed on your PC, you will 
have an Acrobat tab on the ribbon. All Portland staff can have Acrobat Pro DC installed on their 
machine. 

To save a document as a PDF (if you have the Acrobat tab in the ribbon): 

1. Open a Word document. 
2. Prepare the document so that it is accessible. 
3. Click the Acrobat tab. 
4. Click the Preferences button. 
5. In the Application Settings section, make sure that there is a checkmark in the box for this 

option: Enable Accessibility and Reflow with Tagged Adobe PDF. 

6.  
Click OK. 

7. Click the Create PDF button. 
8. Click the Save button. 

To save a document as a PDF (if you DO NOT have the Acrobat tab in the ribbon): 
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1. Open a Word document. 
2. Prepare the document so that it is accessible. 
3. Click the File tab. 
4. From the menu, select: Save as. Select the location where you want to save the file (i.e. 

Current Folder, Recent Folders, or Browse options). 
5. Click the drop-down arrow for the Save as Type box and select: PDF. 
6. Click the Options button. 
7. Click to place a checkmark in the box for this option: Create Bookmarks Using. 
8. Underneath the option, ‘Create bookmarks using’, click: Headings. 
9. Click to place a checkmark in the box for this option: Document Structure Tags for 

Accessibility. 

 
10.Click OK. 
11.Click the Save button. 

Details for accessible PDF documents 
The easiest method is to use accessible source documents and convert to PDF. If you created a 
PDF from a scanned document, then it will be inherently inaccessible to assistive technology and 
other assistive technologies. The document will also be less useful because graphic 
representations of text cannot be selected, edited, or searched. 

In this case, it is necessary that you convert the scanned images of text to searchable content 
using optical character recognition (OCR) before addressing the accessibility features of the 
document. 

The second basic requirement for a PDF document to be accessible is for it to be "tagged" with 
hidden labels ("tags") that describe the structure of the document (e.g., that text should be 
interpreted as a header, paragraph, table cell, etc.). Assistive technologies use these tags to 
convey the document's information effectively to people with access needs, and use the tag tree 
to convey reading order. Each element in the document should be identified with the appropriate 
tag. 
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The other requirements for a PDF document to be accessible (e.g., alternate text, logical reading 
order, etc.) can only all apply once the document is tagged. 

Adobe Acrobat Pro DC provides an Accessibility Check within the Accessibility tool panel. Color 
contrast and logical reading order will always need manual checks. The logical reading order for 
assistive technology is based on the Tags panel order. 

In addition to Full Check, Acrobat provides other methods to check PDF accessibility: 

• Use the Reading Order tool, along with the Tags, Order, and Content panels to examine the 
structure and contents of a PDF. 

Adobe has provided a series of tutorials on accessible PDF creation. 

PowerPoint 
The following tips will help make your PowerPoint presentations more accessible: 

• Use built-in templates and layouts. 
• Try to avoid the use of text boxes (use content placeholders on template layouts instead). 

Text boxes are generally accessible in PowerPoint but require remediation if converted to 
Word for large print or braille. 

• Every slide must have a unique descriptive title. 
• Add alternative text descriptions to images. Images on the Slide Masters are ignored by 

assistive technology. 
• Use bulleted and numbered lists. 
• Smart Art components are not accessible. Paste as a graphic and describe the graphic in Alt-

text. 
• Make sure slide contents can be read by assistive technology in the order that you intend. 

The Selection and Reading Order Panes control the reading order for the PowerPoint file. The 
Selection Pane reads from bottom to top, and the Reading Order Pane reads from top to 
bottom. The panes are linked, so a change in one pane will change the order in the other 
pane. 

• PowerPoint Designer may interfere with Reading Order. Be sure to confirm the order in the 
Selection or Reading Order Panes. 

• Add meaningful and accurate hyperlink text. 
• Ensure that color is not the only means of conveying information. 
• Use sufficient contrast for text and background colors. 
• If you use tables, create a simple table structure for data only, and specify header 

information. 
• Run the accessibility checker to identify possible issues. 

More details at: Creating accessible PowerPoint presentations from Microsoft 

Please let me know how I did by filling out this short form 
https://forms.office.com/g/6uhz8P2s4v 

 

https://experienceleague.adobe.com/docs/document-cloud-learn/acrobat-learning/advanced-tasks/accessibility-series/accessibility-series.html?lang=en
https://support.microsoft.com/en-us/office/make-your-powerpoint-presentations-accessible-to-people-with-disabilities-6f7772b2-2f33-4bd2-8ca7-dae3b2b3ef25
https://forms.office.com/g/6uhz8P2s4v
https://forms.office.com/g/6uhz8P2s4v
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